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Start

Mints is a growing collection of tools to provide deeper insight into macOS, to help you understand how its features work,
and to help diagnose its problems. In this beta-release, eight tools are provided: these provide log extracts covering iCloud,
TCC and privacy protection, and Time Machine backups, look for Universal binaries, and show information about the Mach
timebase, hardware, mounted volumes and keychains.

Complex systems in macOS write dialogues to the log while they operate. Following these in a normal log extract can be
difficult, because lines in each conversation are interspersed with other irrelevant entries. Mints’ log browsers are different
because they bring together entries from many different sub-systems and services, helping you to follow those dialogues.
The use of colour to distinguish different sub-systems makes these conversations even more understandable.

® ® Mints Time Machine log
Period | -20| L min [& relativeto 14/07/2020, 16:00:34 N Now
Time Machne @ DAS @ cTs @ Other
Get log Save

2:10.153 [other Y
F5C 3FD397D

options: 768
20-07-14 15:44:51.668 DuetAS @:com.apple.backupd-auto:@45ABB: [

{name: DeviceActivityPolicy, policyWeight: 2.000, response: {Decision:
Can Proceed, Score: 0.40}}

{name: MemoryPressurePolicy, policyWeight: 5.000, response: {Decision:
Can Proceed, Score: 0.50, Rationale: [{[memoryPressurel: Required:2.00,
Observed:1.00}, 1}}

] sumScores:31.810000, denominator:35.510000, FinalDecision: Can Proceed
FinalScore: ©.895804}

20-07-14 15:44:51.668 DuetAS '@:com.apple.backupd-auto:@45ABB'
CurrentScore: 0.895804, ThresholdScore: 0.758907 DecisionToRun:1
20~ 14 15: 69 CTS-XPC DAS told us to run com.apple K

20-07-14 15:44:51.77@ TimeMach TMPowerState: 2
20-07-14 15:44:51.770@ DuetAS STARTING activity @:com.apple.backupd—
auto:045ABB <private>!

=» Contents =»> Main window
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Main window

o @® Mints — macOS Version 10.15.6 (Build 19G2021)

iCloud Log Window
TCC Log Window

Time Machine Log Window

Get Mac Info Get Volume Info Get Keychain Info
Mach Absolute Time

Universal Binary Checker

=» Contents

The main window currently offers eight buttons, which open:

- the =» iCloud Log Window, to explore iCloud messages in the log,

the =» TCC Log Window, to explore TCC and privacy system messages in the log,

the =% Time Machine Log Window, to explore Time Machine backup messages in the log,
+ =» Get Mac Info, to get information about your Mac’s hardware,
- =» Get Volume Info, to get capacity information about all currently mounted volumes,

- =>» Get Keychain Info, to get information about keychains,

- =» Mach Absolute Time, to get information about clock rate and conversion factors,
- the =» Universal Binary Checker, to discover which apps and other code runs native on Apple Silicon

Macs (available in Mojave and later only).

When you close this window, Mints will quit.

=» Log window controls
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Log window controls

@® ® Mints Time Machine log
Period | -20{C min |3 relative to 14/07/2020, 16:00:34 # Now
Time Machne @ DAS @ CTs @ Other
Get log Save

<private bt
6E3 j Z r’,V‘T[: 7‘ - P7 : U

anic/TheTimeMachineMechan

options: 768

20-07-14 15:44:51.668 DuetAS @:com.apple.backupd-auto:045ABB: [

Each log window in Mints offers a simple method to specify the precise period over which log entries are to be
extracted. This is based on a reference time, entered in the relative to box using its standard controls, and a
Period offset from that reference, set using its stepper arrows or by editing the text directly. You can also copy and
paste times in the relative to box: simply select an item in the box and use the normal commands.

The offset entered in the Period box has a popup menu to determine its units. There is also a button Now which
will set the reference time to the immediate present. Use that with a period of —20 sec to get log entries over the
last 20 seconds.

To get a log extract for the 1 minute before a reference time, simply set Period to —1 and the popup menu to min.
To obtain an extract for 10 seconds each side of a time in the past, the total period wanted is 20 seconds. You can
either specify that using the reference time at the start of that period and 20 sec, or the time at the end of the
period and —20 sec.

=» Log window controls (concluded)
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Log window controls (concluded)

The shortest period which can be used here depends on the version of macOS. In Sierra, periods less than about
30 seconds are unreliable, and entries can be missed. In Mojave and Catalina, shorter periods can be used, even
below 10 seconds if you wish.

Times in the relative to box are in the current time zone for the set date. On days when clocks change, they use
the second of the two zones. For example, when the change to summer time occurs on a day, times entered here
for that day use summer time throughout.

The row of controls below the time settings set which sub-systems are shown in the log view in the main part of
the window. Each uses an emoiji to indicate the colour in which those log entries are displayed.

The last controls are two buttons: Get log, which runs the log show command to fetch a fresh log extract, parse
and display it, and Save, which saves what’s currently displayed of the log in Rich Text format, which you can also
do through the Save command in the File menu.

To enlarge the size of the text in any log extract, press 3 +; to reduce the size, press ##—.

=>» iCloud log
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iCloud log

[ JOX ) Mints iCloud log
Period | -20| l sec a relative to  14/07/2020, 16:02:00 o Now
CloudDocs @ CloudKit @ MMCS @ Other
Get log Save

StateComplete 1

getOP_MODE@67:no
20-07-14 16:01:44.
getOP_MODE@67:not
20-07-14 16:01:44.
getOP_MODE@67:not support

2491077
on this inter

wlan@.A[542659]

20- 11 [kernel]l 2491 .147504 wlan@.A[542660]
updatelLQME3331 core RSSI to rt

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for with 1
proxy.

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for
bundleID:<private> with 1 proxy.

20-07-14 16:01:46.060 CloudKit TCC accepted a token for
bundleID:<private>, proxy:<private>

20-07-14 16:01:46.060 CloudKit Checking TCC authorization for
bundleID:<private> with 1 proxy.

20-07-14 16:01:46.060 CloudKit TCC accepted a token for
bundleID:<private>, proxy:<private>
20-07-14 16:01:47.279 [ke 1] TX(44:94:FC:2
E ed OtherErr> BE<@ @ @ 0> BK<@ 0 @ 0> VI<
(5001ms)
20-07-14 16:01:47.279 [kernel] L3 Control VO TX(44:94:FC:20:67:6D)

:67:6D) <Success NoACK
9 0 0> VO<@ 0 0 o>

The iCloud log extract shows entries from the three major sub-systems involved in iCloud transactions, and
various related services and the kernel in the Other category. These are the same as shown in my free iCloud
utility Cirrus.

=> TCC log
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TCC log

[ JOX ) Mints TCC & privacy log
Period | -20| C sec a relative to 14/07/2020, 16:01:40 z Now
TccC @ LaunchServs @ securityd @ Other
Get log Save

01:20.338 securityd could not enable test hierarchy: no UAT

PMRD: setAggressivenes

rnel 54.125156 wlan@.A[542641]

uj @ I re RSSI t

20-07-14 01:21.768 LaunchServ

invalidated for timeout.

20-07-14 16:01:21.882 LaunchServ LSExceptions shared instance

invalidated for timeout.

2 4 16:01:22.273 kernel
OtherErr> BE<@ @ @ 0>

LSExceptions shared instance

TX(44:94:FC:20:67:6D) <Success NoAC
BK<@ © @ 0> VIO 0 0 0> V0<@

E i Othe ]

20-07-14 16:01:25.659 LaunchServ LSExceptions shared instance
invalidated for timeout.
20-07-14 16:01: ke

33576 wlan@.A[542642]

932) deny(1)

The TCC log extract shows entries from the three major sub-systems involved in controlling privacy and controlled
access in Mojave and later. The Other category here includes additional services and the kernel. These are the
same as shown in my free utility Taccy.

=» Time Machine log
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Time Machine log

[ JOX )} Mints Time Machine log
Period | -20|C min E relative to  14/07/2020, 16:00:34 ° Now
Time Machne @ DAS @ cTs @ Other
Get log Save

20— 14 15:44:51.668 DuetAS @:com.apple.backupd-auto:045ABB: [

{name: DeviceActivityPolicy, policyWeight: 2.000, response: {Decision:
Can Proceed, Score: ©0.40}}

{name: MemoryPressurePolicy, policyWeight: 5.000, response: {Decision:
Can Proceed, Score: 0.50, Rationale: [{[memoryPressurel: Required:2.00,
Observed:1.00}, 1}}

] sumScores:31.810000, denominator:35.510000, FinalDecision: Can Proceed
FinalScore: ©.895804}
20-07-14 15:44:51.668 DuetAS '0:com.apple.backupd-auto:045ABB"'
CurrentScore 0. 895804 ThresholdScore 0.758907 DeclslonToRun 1

144:51 PC AS told us to run com.apple.backupd

hange 1
com.apple
20-07-14
com.apple 831
20-07-14 15:44:51.770 TimeMach TMPowerState: 2
20-07-14 15:44:51.770 DuetAS STARTING activity @:com.apple.backupd-

auto:@45ABB <private>!

The Time Machine log extract shows entries from the three major sub-systems involved in scheduling,
despatching and making Time Machine backups. The Other category here shows related services, but doesn’t

include the kernel. Although based on the extracts analysed by my free utility The Time Machine Mechanic, these
extracts are new for Mints.
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Get Mac Info

[ NON ) Mints Mac Info

Mac model = iMacProl,1
Serial number = CO2VX2LXHX87
Logic board ID = Mac-7BA5B2D9E42DDD94

This window lists information about your Mac’s hardware. This includes:
+ the model designator, e.g. iMac17,1
+ the serial number of that specific Mac
+ the ID for the logic board.

Further items will be added to this list in the future.

Increase the size of the text used with 3 +; to reduce the size, press ¥&— . Save the text to a text file using the Save...
command in the File menu.
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Get Volume Info

O ® Mints Volume Info

Checked by Mints (VolSizes) at: 2020-09-21 12:50:43 +0000
Free space on /Volumes/TB4-10-15-4 — Data is 1.85 TB
out of total 2 TB
used space 151.62 GB
available for important usage 1.85 TB
available for opportunistic usage 1.85 TB
Sparse file storage availability = true
Journalling NOT available
Free space on /Volumes/ThunderBayl is 636.62 GB
out of total 2 TB
used space 1.36 TB
available for important usage 638.27 GB
available for opportunistic usage 636.98 GB
Sparse file storage availability = true
Journalling NOT available

This window lists capacity information for all volumes currently mounted in the path /Volumes. This includes:
+ total free space
+ total capacity of the volume
+ the derived used space
+ the amount of space available for ‘important’ and ‘opportunistic’ use
+ whether APFS sparse files and journalling (HFS+ only) are available.
On APFS volumes, this should include mounted snapshots.

Increase the size of the text used with 3+; to reduce the size, press 3&— . Save the text to a text file using the Save...
command in the File menu.
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Get Keychain Info

[ JOX | Mints Keychain Info
Check

Default (login) /Users/hoakley/Library/Keychains/login.keychain-db
keychain

unlocked readable writeable

Lock

Mac UUID: 4BB99205-CB23-5758-88E0-E59A16FF4605

Keychain Services version: 33718272

‘% Found default keychain.

The default keychain is now unlocked, readable, writeable.

Default keychain path: /Users/hoakley/Library/Keychains/login.keychain-db
& Current keychain search path:
/Users/hoakley/Library/Keychains/login.keychain-db
/Users/hoakley/Library/Application Support/Adobe/AIR/ELS/
com.adobe.formscentral.FormsCentralForAcrobat/PrivateEncryptedDatak
/Users/hoakley/Library/Keychains/loginMPro.keychain-db
/private/var/folders/t9/dsdtkd0161b3w6fcjhlyqvjm0000gn/T/accountsKeychainExportBC5/
accountsKeychainExport.keychain

/Library/Keychains/System.keychain
/Users/hoakley/Library/Keychains/login.keychain-db
/Users/hoakley/Library/Application Support/Adobe/AIR/ELS/
com.adobe.formscentral.FormsCentralForAcrobat/PrivateEncryptedDatak

This window has three simple button controls:
« Check, which runs its checks and updates the information in its text boxes;
+ Unlock, which unlocks your default (login) keychain;
+ Lock, which locks your default (login) keychain.

When you click on the Check button, Mints runs its full battery of tests, and completes the text boxes as shown below.

Displayed in the Default (login) keychain box is the full path to the keychain which macOS is using as your main user
keychain at present. Even if you are using iCloud Keychain, this should be a path to the file named login.keychain-db in the
Library/Keychains folder of your Home folder. If it isn’t, then you need to establish why.

=» Get Keychain Info (concluded)
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Get Keychain Info (concluded)

Below that box are three smaller boxes, which tell you whether that default keychain is locked, readable, and writeable.
You can change two of those by clicking on the Unlock or Lock buttons nearby. When you click on Unlock, a dialog will
appear requiring you to enter the password for your default keychain (which should be the same as your normal user login
password) in order to unlock that keychain, although in Catalina that may only appear when you click on Lock.

Mints wants to use the “login” keychain.

Please enter the keychain password.

Q
L OO0 password: ||

? Cancel U

The bottom scrolling box contains the hardware UUID number of your Mac, its version number of Keychain Services, all the
information from the other boxes, and a lot more too.

You can save that to a text file using the Save... command in the File menu. You can also select, copy and paste any of
the text, but cannot modify it within this app.

You can resize text in the lower scrolling window between 4 and 24 points using ¥+ to enlarge and - to reduce the size.

=» Keychain Details
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Keychain Details

Mac UUID: this should correspond with the Hardware UUID given in System Information.
Keychain Services version: this should be 33718272 for all versions of macOS from 10.12 to 10.15.

Default keychain path: should be /Users/[username]/Library/Keychains/login.keychain-db where [username] is the short user name
of the current user.

Current keychain search path: should include the default keychain and /Library/Keychains/System.keychain.

Keychain system search path: should include /Library/Keychains/System.keychain.

Keychain common search path: should include /Library/Keychains/System.keychain.

Keychain dynamic search path: most probably empty.

Keychain user search path: should include the default keychain.

Contents of ~/Library/Keychains: should include login.keychain-db, and is likely to include metadata.keychain-db too. For each file
found, the date and time of last modification is given first, then that of the file’s creation, then the size in bytes. The default keychain
should not be empty.

Contents of ~/Library/Keychains/[UUID]: this is the folder used for iCloud Keychain, or for the Local ltems listed in Keychain
Access. It may not exist, but if it does it should include keychain-2.db at least, and sometimes much more.

Contents of /Library/Keychains: should include System.keychain, and may well also include the Apple Push Services keychain
apsd.keychain

Contents of /System/Library/Keychains: should include SystemRootCertificates.keychain and is likely to contain EVRoots.plist,
X509Anchors, and SystemTrustSettings.plist.
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Mach Absolute Time

@ ® Mints Mach Timebase Info

Running as Intel code:
Timebase numerator = 1
denominator = 1

factor = 1.0

Mach Absolute Time (raw) = 2812811885701462
Mach Absolute Time (corr) = 2812811885701462

This window displays conversion factors and other information about Mach Absolute Time, which differ between
Intel and Apple Silicon hardware, and between Intel code running using Rosetta 2 and native ARM code on Apple
Silicon systems.

This first line states which architecture the code was run on, then gives the two integers for the Mach timebase
correction, and the correction factor; multiply raw time values by that to scale them from ticks to nanoseconds.
Finally, it gives the current raw time, and that time after correction.

To discover the factors applied to Intel apps running in Rosetta 2 translation on an Apple Silicon Mac, force Mints
to Open using Rosetta on that Mac.
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Universal binary checker (Mojave and later)

o @ /Users/hoakley/Documents/Oarchtests

Folder Flush
Scan Check all bundles Check Mach-O Save

Listing of all bundles which have ARM64 code in the folder /Users/hoakley/
Documents/Oarchtests:

[Users/k Oarcl /ArchiChect.app

JUsers/t Oarc /ArchiChect.app/C AacOS/ArchiChect

/Users/hoakley/Documents/Oarchtests/Cil al

[Users/t chtests/Cirrus..
y

0S/Cirrus

0S/Podofyllin

Found 10 items which have ARM64 code, out of 7082 scanned in /Users/hoakley/
Documents/Oarchtests (including Mach-O files)
Checked at Monday, 20 July 2020 at 16:59:20 British Summer Time

Before scanning for Universal software, decide whether you just want apps scanned, or whether you want all code-containing
bundles scanned. To scan apps only, leave the checkbox labelled Check all bundles unchecked; to scan all bundles, ensure it is
ticked (the default).

Next, decide whether you want all executable (Mach-O) code files scanned too. These include dynamic libraries (dylibs), command
tools, and other code which is not delivered in a bundle. To scan all executable code, ensure that the checkbox labelled Check
Mach-O is ticked (the default); for a basic scan, leave that checkbox unchecked. Scanning all bundles and all Mach-O files will take
significantly longer.

Then decide which folder you wish to scan. You can select that in either of two ways:

+ leave the Folder text box empty, and click on the Scan button. You will then be prompted to select the folder using the normal
Open File dialog;

+ enter a standard path into the Folder text box. You can use the standard shortcut of ~ to indicate your Home folder. Once you
have entered the path, click on the Scan button to start the scan. If the Flush checkbox is ticked when you do this, the path in
the Folder text box will be cleared when the scan starts; if you uncheck the Flush checkbox, your path will be left for you to
edit it for the next scan.

=>» Universal binary checker (concluded)
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Scanning takes time. If you put the root path / in the Folder text box, this can take many minutes, even an hour or
so. You may wish to scan top-level folders like /Applications one at a time rather than attempting to scan your
entire Mac. During this period, the window shows a busy ‘spinner’ next to the Scan button, and you can work
normally with other apps. Give the app time to complete its scan, and once complete it will display the results.

Scanning takes plenty of memory. Because of the deep traversal which it uses, Mints consumes memory by the
GB in order to check every nook and cranny in the folder it is scanning. This should work fine with virtual memory,
though. Again, you can reduce this by performing scans on smaller folders.

When a scan is complete, the title of the window will change to show the folder which has just been scanned.
Change the size of the text in the output using 3+ to make it larger, to a maximum of 60 points, or 3— to make it
smaller, to a minimum of 4 points.

To save the results of a scan as a text file, click on the Save button, or use the Save... command in the File menu.
You will then be prompted to select the name of the text file.

The scanner performs a deep traversal of the chosen folder, using Bundle.executableArchitectures to list
executable architectures for each bundle. To check for Mach-O code files, it first inspects the ‘magic’ initial four
bytes of every file. If it finds that they are 0xfeedface, it then directly inspects the subsequent Fat Architecture
slices to check whether the supported architectures include ARM64.
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Updates

Whenever you open Mints, it may check to see if an update is available. This doesn’t use the popular Sparkle mechanism
for updating in place, but works as detailed here.

Once Mints has successfully completed its integrity check, it checks whether update checking has been turned off in its
preferences file. If that has, it abandons any attempt to check for updates. If checking is allowed, it then checks when it last
checked for updates. If that was more than 12 hours ago, it continues to perform the check. It then connects to my GitHub
server, from where it downloads a list of current versions of my apps. It doesn’t upload any data to the GitHub server at all,
and no statistics beyond GitHub normal connection figures are collected either: no personal identifiers are recorded.

If there is an update available, Mints then checks that its location is on this WordPress blog, and posts a dialog which
invites you to download the update.

If you click on the Download button, it then points your default browser at that update, which should trigger the update to
be downloaded to your normal downloads folder. The update is received as a regular Zip archive, and is exactly the same
as you would download from the Downloads page here. It also carries a quarantine flag, so that when you unZip it and
install the app inside, it undergoes normal first run ‘Gatekeeper’ security checks. If you click on the Ignore button, Mints
won’t remind you about it again for another 12 hours.

An additional item at the end of the Help menu explains the update status. If no update check is performed, or the check
fails, the last item reads Update not checked. If the check is performed and update information is obtained, even when no
update is available or you decline to download it, that menu item reads Checked for update and is ticked (but still
disabled).

You can customise this behaviour by changing Mint’s preferences. The keys to use are:
noUpdateCheck, a Boolean. When set to true, this disables all update checking. Default is false.
updateCheckInt, a real number (Double). When set to a value greater than 1.0, the minimum time interval between checks, in
seconds. Default is 43200, which is 12 hours. If you set it to any value less than 1, Ulbow will reset it automatically to that
default.

To change either of these, use a Terminal command of the form
defaults write co.eclecticlight.Mints updateCheckInt '10'

which works properly through the preferences server cfprefsd.
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Further Information

The monospace font using in versions of macOS up to and including Mojave is monospacedDigitSystemFont;
that used in Catalina is monospacedSystemFont, which is unfortunately not available in earlier versions of
macOS. Both are used in their regular weight.

Predicates used to obtain log extracts include:
* subsystem == "com.apple.clouddocs" OR subsystem == "com.apple.cloudkit" OR subsystem ==
"com.apple.mmcs" OR processImagePath CONTAINS[c] "cloudd" OR processImagePath CONTAINS[c]

"bird" OR processID = 0 (for iCloud)

* subsystem == "com.apple.TCC" OR subsystem == "com.apple.launchservices" OR subsystem ==
"com.apple.securityd" OR subsystem == "com.apple.sandbox" OR processImagePath CONTAINS[c]
"tccd" OR processImagePath CONTAINS[c] "sandboxd" OR processID = 0 (for TCC)

* subsystem == "com.apple.TimeMachine" OR (subsystem == "com.apple.duetactivityscheduler" AND
eventMessage CONTAINS[c] "Rescoring all") OR (subsystem == "com.apple.xpc.activity" AND

eventMessage CONTAINS[c] "com.apple.backupd-auto") OR eventMessage CONTAINS[c] "backup" OR
eventMessage CONTAINS[c] "Time Machine" OR eventMessage CONTAINS[c] "TimeMachine" (for Time
Machine)

Extensive information about Mints and the unified log is available from the Eclectic Light Company blog, and the
product page in particular. That can be accessed through the Mints Support command in the Help menu too.

Change list

1.0b8:

+ added Mac Info feature
1.0b7:

« added Volume Info feature
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+ added Keychain Info feature
+ added support for saving via menu command to main windows.
1.0b6:
+ added Mach Absolute Time feature
+ minor tweaks to the interface.
1.0b5:
+ changed algorithm used by Universal Binary Checker to stop using lipo
+ Universal App for for Intel and Apple Silicon Macs.
1.0b4:
+ changed standard log text colours to black/white, red, blue, green
+ added Universal Binary Checker for 10.14 and above.
1.0b3:
+ tried to fix further bug opening log windows in Sierra.
1.0b2:
+ fixed weird bugs in the log window nib.
1.0b1:
+ first beta release, with iCloud, TCC and Time Machine log browsers.

22 September 2020.
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